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This document, including attachments, is not for general circulation, but for distribution to a

limited number of specific corporations and individuals that are known to St.George Pty Ltd

(“Company”). It is in draft form and its contents are subject to change, including changes of

substance. Any person choosing to act on information contained in this document is advised

to verify the information.



Introduction
The Batch Processing Application is a secure digital eCommerce business solution that is used

to process batches of financial transactions.

The core of the system has been written in Java providing platform independence and

consistency across a wide range of environments.

The Batch Processing Application securely submits purchase transactions to the St.George

Internet Payment Gateway. The transaction data is contained within Batch Files created by the

merchant. Batch files are comma separated value text files which contain all the necessary

information to process a purchase transaction on a credit card.

This document provides a comprehensive description of the layout and format of a batch file as

well as features of the Batch Processing Application and procedures for merchants.

Please note:

The Batch application is certified and tested only on Windows 2000, XP & 2003.
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Batch File Format & Layout
Batch files can be created in any text editor such as Notepad or Wordpad; or they can be created

in spreadsheet packages, such as Excel and saved with a file type of “CSV(Comma

Delimited)(*.csv)”.

Important: The format of the batch file is exacting. Batch files have to be produced

accurately otherwise they may fail to load into the Batch Processing Application or the

transactions may not be processed as expected.

Important: In order to accommodate increased functionality the file format below is applicable

to versions 3.1 or newer of the Batch Processing Application. Files produced for prior versions

of the application will not work with this version. To ensure you are using the current version

of the application visit the downloads page at https://www.ipg.stgeorge.com.au/download.asp

The layout and format of the batch file is as follows:

Comments

• Comment lines can be included in the batch file.

• Lines beginning with the characters // will be ignored by the Batch Processing application. 

i.e. //This is a batch file comment

Batch ID

• The first non-comment line of the batch file must be a BatchID Record. It looks like this:

<batchid>20020522</batchid>

• The BatchID must be unique for each batch.

• It is recommended that the BatchID is the date the batch is submitted in the form of

YYYYMMDD.

• If you submit more than one batch in one day you can add another character to the batch id. 

e.g.

First batch of the day……<batchid>20020522a</batchid>
Second batch of the day…<batchid>20020522b</batchid>
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Transaction Details

• Individual transaction records follow the BatchID.

• Each line will contain the details of one transaction.

• Each transaction record is made up of the following elements, separated by a comma:
TransType,ClientID,ReferenceNumber,CardNumber,ExpDate,CVC,Amount,TxnRef,AuthCode,
MerchantRef

Element Description

TransType C for credit, or purcahse transaction
R for refunds
P for Pre authorisation
M for Completion 
to enable Pre authorisations and Completions on your facility, 
please contact your Relationship Manager.

ClientID The Internet Payment Gateway ClientID supplied by St.George.
Only one ClientID can be used per batch

ReferenceNumber The transaction reference number.
Each Reference number must be unique per batch.

Cardnumber The credit card number.

ExpDate The credit card expiry date: MMYY.

CVN The Card Verification Number (CVN)is the last three or four digit
number printed on the signature strip of a credit card.

Amount The transaction amount: dddd.cc
(dollars.cents - e.g, 24.99).

TxnRef The Transaction Reference number of the purchase (for refunds) or
the Pre authorisation (for completions).

AuthCode The 6 digit Authorisation Code from the Pre authorisation transaction.
This field is only used for completions.

MerchantRef An optional comment specified by the merchant. Can be used to
record the customers or cardholders name for example.

Transaction Detail Notes:

• Spaces and punctuation marks, (e.g. , “ :*$) are only permitted in the MerchantRef field. 

• If you do not have the CVN for the customer’s card then separate the expiry date and the
amount with two commas with no space between them. eg, expdate,,amount,

• The amount field must be formatted and rounded to two decimal places.
The amount must include the decimal point ‘.’
The amount must not include the dollar symbol ‘$’.
The amount cannot be negative.

• Only the MerchantRef field may be left blank. If there is no MerchantRef then there must not
be any characters after the comma following the amount field.

• It is recommended that you adhere to a common naming convention for batch files. Ideally,
name the batch file extension “.dat” (generally meaning “data”), e.g. BatchFeb.dat. Although,
recommended, the batch processing application will accept any file name and extension.

Sample batch file format and layout

//This is an example batch file containing the transactions for
//ABCXYZ Pty Ltd
//for the period: 01/10/06 - 31/10/06
<batchid>20061101</batchid>
C,10000001,1,4111111111111111,0907,,1.00,,,purchase_transaction
R,10000001,2,,,,1.00,2230000001111111,,refund_transaction
P,10000001,3,4111111111111111,0907,,1.00,,,preauth_transaction
M,10000001,4,,,,1.00,2230000002222222,936343,completion_transaction
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Overview of the Batch Processing Application
The Batch Processing Application enables merchants to directly upload batches of payments

directly into the St.George Internet Payment Gateway using SSL secure encryption.

Batch Processing Procedure

To process a batch and view the results follow these steps:

1. Prepare your batch file.

2. Login to the Batch Processing Application.

3. Select your batch file.

4. Load the batch.

5. If there are any errors reported, view the batch file and correct the problems.

6. Process the batch when it has been successfully Loaded.

7. View the transaction results in a report when the batch has been processed.

8. All transactions should be reconciled in the Merchant Admin Console (MAC).

The batch processing application interface is intuitive and most functions are self explanatory,

however a detailed description of the program functions is contained in the System Features

section of this document.

System Features

On starting the Batch Processing Application you will be presented with a window with pulldown

menus and several toolbar icons. The Security Settings dialogue panel appears for login.

All windows can be resized and the toolbar can be moved by clicking and dragging with the

mouse.
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Security Settings and Login

Only a registered St.George merchant can access the Batch Processing Application.

The first window displayed upon start-up is the Client Identification and Security Settings

window.

In the ClientID field, you must enter your ClientID (“1000....”, as assigned by St.George Bank).

The Keystore Location field is the location and file name of the keystore (“java.cert”) for your

identifying certificate. You can browse for the location and name of this file by pressing the

Select button.

The Keystore Passphrase field is your certificate password.

Click OK to login or cancel to terminate your login.

Note: St.George will provide the Keystore and Passphrase in a separate correspondence to

the Batch Application Software.

Important: Your password is your key to security within the Batch Processing

Application. Never divulge your password to anyone else.
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Toolbar Icons

Security Settings

The Security Settings icon opens a new window that allows login to the system.

A detailed description of the Security Settings functionality is contained in the Security Settings

and Login section of this document.

Reports

The Reports icon opens the Report Generation window that allows you to select and view reports

of processed files.

A detailed description of the reports functionality is contained in the Using Reports section of

this document.

Batch Database

The Database icon displays the batches that have been successfully loaded.

Batch File Help

The Help icon displays help documents for the Batch Processing Application.

Please note: Ensure you are connected to the internet – this will link you to the ‘download’ area

where you are able to download the ‘Batch Application User Guide’.
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Batch Settings
The Batch Settings window allows you to select a batch file and define parameters for that

batch.

Selecting a new batch file

The Load New Batch option allows you to specify the path and name of the batch file you wish to

load.

You can either type the full path into the field, or browse for the file using the Select File button.

Viewing a batch file

When a batch file has been selected you can click the View File button to see the contents of the

file.

A window opens which displays the contents of the batch file. Within this window you can edit

the file and make any changes necessary.

Editing a batch file

The file can be edited within the view window.
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Saving a batch file

The file can be saved using the existing file name or another name by clicking the File menu and

selecting Save or Save As.

Note: If you change and save a file after it has been loaded the changes will not be reflected in

the loaded file.

Loading A Batch File

The Load Batch button performs a pre-process validation of the selected batch file.

All batches must pass the pre-process validation before they can be processed.

If the batch files details are correct this message box will be displayed.

You can now select Process Batch, which will send the transactions to the Bank.

Note: Pre-process validation in the Batch Processing Application does not guarantee that the

bank will accept the transactions.

Batch File Validation Errors

If there are any errors in the batch file a Validation Report is displayed in a new window.

The report displays the Line number, Field number and an Error Description of the problem.

Note: The Line number refers to the lines in the file including any comment lines; not just the

number of transactions.

If the batch validation report is empty, please check the following:

• Does each row contain the correct amount of data fields (10) separated by commas (9)?

• Are there no digits missing? 

ie. ClientID: 8 digits; 

Credit Card No.: 16 digits (except for Amex/Diners Cards).

St.George Batch Processing Application – Operating Guide

Page 11

Commercial in Confidence



Correcting Batch File Errors

Errors can be corrected directly in the View File window. These errors must be corrected before

the file can be processed.

After making corrections the batch file can be saved using the existing file name or another

name by clicking the File menu and selecting Save or Save As. The file must then be reloaded.

The combination of the Validation Report and the View File window enables you to quickly rectify

any errors in the batch file without regenerating the file from an external system.

You can Load (pre-process) a batch file as many times as you need.

Note: If any corrections are made to the batch file you have to Save the batch file and then Load

it again.

Loading Multiple Batches

By selecting the Load New Batch option and the Load Batch button. Multiple batches may be

loaded into the system’s memory prior to processing the files.

Also see the Processing an Existing Batch section of this document.

Batch Already Loaded

If you try to load a file that contains a BatchID that already exists in the Batch Processor’s

database then an error will be displayed in the Validation Report window.

To load the new batch file you will need to change the BatchID contained in the file. Alternatively,

if the previously loaded file is incorrect it can be deleted from the database. Also see the Batch

Administration section of this document.
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Process Batch
When a batch file has been loaded and verified the Process Existing Batch option is

automatically selected and the Process Batch button activates.

In the Process Existing Batch drop-down field will be the Batchid taken from the header record

of the batch file.

To submit the batch transactions to the bank click the Process Batch button.

WARNING: Before clicking on “Process Batch” always double check that the batch you’re about

to process contains the right transactions (View File) to avoid double billing.

Simultaneous transaction processing

Clicking the Process Batch button opens communication between the Batch Processing

Application and the St.George Internet Payment Gateway. During this communication session,

the system determines the number of terminal identifiers available, which in turn enables

concurrent processing of transactions, eg. A merchant account with 5 terminal identifiers can

process 5 simultaneous transactions, which significantly reduces the total processing time of a

Batch. Additional terminal identifiers can be requested by contacting the Help Desk on

1300 650 977.

The St.George Batch Processing Application requires an established internet connection. Ensure

that a connection is established prior to sending the batch file. Firewalls and Proxy Servers may

interfere with our product. If this is the case, an exemption for the address

www.gwipg.stgeorge.com.au may need to be created. You can check connectivity by launching

Internet Explorer on the machine where the Batch Application is installed and going to

http://www.gwipg.stgeorge.com.au:3006. If you can see the five squares, you can talk to the

gateway.

A progress indicator bar displays the number of files uploaded and the time elapsed during

upload in the Processing Status window.

Stopping A Processing Batch

Once processing has commenced, clicking the Stop button will terminate transaction

processing. The OK button closes this window.

Stopping the batch process can take a few seconds while the batch program closes all open

sessions to the St.George Internet Payment Gateway.

Procedures for dealing with interrupted batches are contained in the Interrupted Batches section

of this document.

If a batch has been stopped, in can be safely reprocessed. All transactions that were not

processed the first time will be processed this time. Transactions that were approved the first

time will not be reprocessed.
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Processing an Existing Batch

Multiple batches can be loaded and kept in the memory of the system (see the Loading a Batch

File section of this document).

To view the list of all batches Loaded but not Processed, select the Process Existing Batch

option and click the drop-down list immediately below.

To process a batch, highlight the required BatchID and click the Process Batch button

Once the batch is processed, it is removed from the list of existing batches. Details of all

processed batches remain in the batch history file of the system for reporting and to prevent

double processing.

Interrupted Batches

During each transaction process the Batch Processing Application communicates with the

St.George Internet Payment Gateway. This communication logs and monitors the progress of

each transaction, assigning each with a unique process number. Should any transaction not

respond the system will terminate the processing of the batch file.

Before confirming receipt of the entire batch file, the Batch Processing Application receives a

confirmation response from the St.George Internet Payment Gateway. Only then is the batch

reference removed from the existing Process Existing Batch list.

Processing Interrupted Batches

If, for whatever reason, a Batch file fails and not all of the transactions have been submitted to

the bank, the BatchID will still be listed in the Existing Batch dropdown list.

If you wish to process the remaining transactions in a batch, merely resubmit the batch. 

Only transactions that were not processed or were rejected last time will be reprocessed. 

Reload the batch and process.
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Using Reporting
Reconciliation reports for all processed batches can be generated at any time by clicking the

Reports icon on the toolbar.

In the Report Generation window each processed batch will appear in the Select BatchID field.

The BatchID is taken from the field stored in the header record of each batch file.

The Refresh List button refreshes the display of batches. If you have just processed a batch, you

will need to click the Refresh List button before that report will be displayed.

Summary Report show an overview of the transactions processed in the batch. It includes the

number of transactions, number approved and declined as well as the value of transactions

processed.

Detail report provides more information on the individual transactions, including the response

code and text for each transaction.

Click on File then Save As to save your report. The reports can be generated historically for any

batch that appears in the report window.

Note: It is recommended that you name the report file with a “.csv” extension, for example,

ReportJan02.csv. The ‘.csv’ file extension name will enable you to open and analyse the report

file using another external program such as Microsoft Excel.

Note: Nominating a file name that already exists will cause the file to be over written without

warning
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Batch Reconciliation Report

The Batch Reconciliation Report displays in a pop-up detail window.

The Batch Reconciliation Report displays the details of each transaction contained in the Batch

File that has been submitted to the St.George Internet Payment Gateway for processing.

The report details the following elements separated by commas:

Element Description

TxnType The type of transaction. e.g. C(Purchase), R(Refund) etc.

ClientID ClientID number.

ReferenceNumber The Reference Number entered with the transaction.

Carddata Credit card number (for security reasons this data is encrypted).

ExpiryDate Expiry Date. [Format : MMYY]

Amount The transaction value. [Format : $ddd.cc]

Merchantrefcode The Merchant Reference, if one was entered with the transaction.

Txnreference Unique Transaction Identifier Code from the St.George Internet

Payment Gateway.

Authcode Authorisation Code from the customer’s bank.

Settlement The date of settlement.

Responsetext The Response Code text from the bank.

Responsecode The Response Code from the bank.

Error If applicable an error message from the Batch Processing Application.

The details of all sent transactions can also be viewed through the Merchant Administration

Console. Refer to the Merchant Administration Console Operating Guide for instructions.
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Batch Administration

Resetting Batches

Batch Files can be reprocessed in their entireity by clicking the "Reset Status to 'Loaded'"

button. To use this feature, select a Batch ID and then click "Reset Status to 'Loaded'" button.

This batch will again be visible in the "Process Batch" dropdown list.

NOTE: all transactions in the batch will be processed again, including transactions that were

approved the first time the batch was run.

Reprocessing Batches

Batch files can be reprocessed after they have initially been processed.  Selecting a Batch, then

clicking Reprocess Batch will reprocess all transactions that were not approved the first time.

Note that transactions that were approved the first time, or rejected by the validators for

reasons such as Invalid Card Number, Invalid Amount, Amount Not Supplied etc. will not be

reprocessed.  For a full list of Response Codes that will not be reprocessed, please email

IPGSupport@stgeorge.com.au

Deleting Batches

Batch Files can be deleted from the Batch Payment application Database.

To delete a Batch File and all of it’s associated transaction details:

• Select the BatchID from the list.

• Click the Delete Batch button.

Important: If a batch is deleted it is removed entirely from the Batch Processing

Application Database. No reporting relating to this batch will be able to be retrieved by the

Batch Processing Application.

The status of processed transactions is not changed by the deletion of a batch file. If

transactions have been processed and approved the customer will be charged and settlement

will be paid regardless of whether the batch file is later deleted.
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Display Themes
Click the Options pull-down menu to reveal the Theme selections. This option allows you to

change the look and feel, or theme, of the application to reflect your preferred display style.

Each theme has a standard set of window navigation icons that control the window displays.

Functionality within each window remains the same, only the appearance is changed by the

selection of a new theme.

The available Themes are:

• Windows Windows style display

• Motif Unix style display

• Metal Java style display

St.George Batch Processing Application – Operating Guide

Page 18

Commercial in Confidence



Installation
The Batch Processing Application will self-install from the CD provided, or can be downloaded

from https://www.ipg.stgeorge.com.au/download.asp 

If your PC does not support the Autorun function on the CD then in Windows Explorer view the 

files on the CD and run Setup.exe.

Important notes

• The Batch Application is supported on Windows 2000, XP & 2003 only.

• Ensure you are logged in as a ‘Full’ Administrator.

• You must place the St.George Bank client certificate (Java.cert) somewhere on the same PC.

• No other programs are running at the same time.

• Do you have connectivity to the gateway? Launch a browser session on the same machine – 

and type in http://www.gwipg.stgeorge.com.au:3006. If you see 5 squares, you can reach the

gateway.
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Starting the Batch Processing Application
By default the Batch Processing Application will be added to the Window’s Start menu in the

Programs list.

You will need to have administrator access to run the Batch Processing Application.

• Open the Start Menu

• Select Programs

• Select Batch Processing Application

• Click Launch Application

• The Batch Processing Application will start.

Test and Live modes
The Batch Processing Application can be used in both Test and Live modes. The Test mode is

used to allow merchants to create files and process them in a simulated environment to verify

their own processes. The following is a list of credit card numbers that must be used in the Test

environment:

Card Type Card Number

MasterCard 5431 1111 1111 1111

Visa 4111 1111 1111 1111

Any future date can be used as a valid expiry date. The cents value of the transaction will be

returned as the response code for the transaction. ie a transaction for $1.00 will return a

response code of '00 Transaction Approved', a transaction for $1.51 will return a response code

of '51 Insufficient funds'.
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Changing between Test and Live

The Batch Processing Application can be directed to either the Test or Live service by editing its

configuration. To edit, click on “Options”>”Configuration”,

then select the “Connection Settings“ tab.

By changing the port value you can direct the Batch Processing Application to either the Test or

Live service. 

A port value of 3007 will send the transactions to the Test service.

A port value of 3006 will send the transactions to the Live service. 

Once you have changed the port value to the appropriate value, click “OK”. The change will take

effect immediately.
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Additional usage instructions

Transaction Management

In order to keep track of your transactions and to be able to reconcile your submitted batches

with the Merchant Admin Console Transaction Reports, we recommend you follow the process

below:

1. BEFORE LOADING A BATCH, delete all existing batches from the Batch Application database

(use the "Barrel" icon).

2. When creating your batch file, specify transaction information that allows you to easily

reconcile and identify transactions, eg.:

• Use meaningful and unique values for the “ReferenceNumber” field. The reference

number should match the number on any other systems that you have (eg. billing) so that

you can reconcile between the two systems.

• Use meaningful and unique values for the “MerchantRef” field, eg. the customer name,

the product sold etc. so that you can see what the transaction was for.

• Use a meaningful and unique batch id, which specifies the date on which the batch was

submitted, eg. “2003-09-11-batch1”

Transaction Data Example:

C,10000292,#258,5550052401870294,0406,,0011.21,P.Smith – 1x Membership

Note: Please refer to page 6 of this document for format requirements.

3. The “ReferenceNumber” and “MerchantRef” field in the transaction data will appear in all

Merchant Admin Console transaction reports as “ClientRef” and “Comment” field, which

allows you to easily identify a single transaction:

For example, the transaction

C,10000001,1,4564456445644564,0405,,1.00,Product One

will show as

4. Before submitting a batch, double check if this is really the batch that you intended to send.

You can view the Batch file before submitting it (“View”). Only click on "Process Batch" if you

are 100% sure that you have selected the correct batch file.

5. Use the Batch Application Reporting capability to assess which transactions have gone

through or not. Immediately after a batch has been processed, create a Batch Report (“Up

Arrow” icon). The Batch report contains transaction by transaction results. Save this report

for future reference using a unique and meaningful filename which can be associated with

the batch that you submitted.

6. Use the Merchant Admin Console to double-check the results immediately after every batch

that you submit (select "Credit Transactions Report"). If required, you can export the data to

MS Excel (please refer to the Merchant Admin Console User Guide on how to do this).
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7. You can cross reference individual transactions between the two reports by using the

transaction reference field.

Transactions which did not reach the gateway will only show on the Batch Application Report,

but not in the Merchant Admin Console report. You will have to reprocess these transactions.

8. Be careful not to accidentally submit transactions twice. Transactions can only be refunded

manually in the Merchant Admin Console (“Payment Page”). When in doubt, use the

Merchant Admin Console search facilities ("Credit Card transactions report") to locate

transactions in our database.

9. Always keep track of which transactions you send through and when you send them trough.

Have your records ready in case you have an enquiry.

10.Please forward these instructions to everyone within you company that deals with the Batch

Application.

American Express & Diners cards

To be able to process Amex/Diners cards, you need to do the following:

1. Contact Amex/Diners and apply for a Merchant ID on their systems.

2. Once Amex/Diners have set this up, their cards can be processed by our gateway.

AMEX 1300 363 614

DINERS 1300 360 560

Email your Amex/Diners ID to ebssupp@banksa.com.au for our records.

Batch Application Response Codes

The complete list of response codes is now available at

https://www.ipg.stgeorge.com.au/download.asp
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Frequently Asked Questions
Q. Can refunds, authorisations and pre-authorisations be included in the batch upload file?

A. Yes. Pre-authorisations, completions, refunds and purchases can be processed using the

Batch Processing Application. Multiple transaction types can be processed in the one batch.

For information on using the different transaction types in the BPA please see page XX

Q. What happens if the session fails halfway through the batch process?

A. Batches can be reprocessed using the "reprocess batch" button, found in the Batch

Administration screen.

Click the Barrel icon from the toolbar to access Batch Administration.

Q. After clicking on “Load Batch” the Batch Validation report is empty and the batch is not

loaded.

A. Check that the file format of the Batch file is exactly as specified on page 6 and that no credit

card numbers have missing digits.

Q. What is the “keystore location”?

A. The keystore location is the location of the file “java.cert” on your harddrive. This file is sent

to you by email and needs to be copied (“save as”) to your harddrive.

Q. I have trouble logging in to the Batch Application.

A. Check the following:

• Have you selected the correct keystore file (“java.cert”)?

• Have you entered the correct passphrase (case sensitive)?
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